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Using Webforms on Your Site

The Webform module lets you easily create a web form through which users can supply information. The Webform is often used for a Contact Us
form, but could also be used for surveys, feedback or registration information.

You create the form page and then add form fields (components) with entry limits and validation options as well as instructions to users. Data
returned through the form is stored in Drupal and is easily viewed for analysis or exported to Excel. Forms can also be configured to send you an
email alert. And, forms may be saved as a block for use throughout your site, for example, to create a feedback form placed on multiple page

types.

Creating a Webform

The form is created in two steps. The first is to create the page for the form. You'll supply a name and optional description and set any page
options you want. The second step is to create the fields which will be part of the form.

To Create a Form Page

. From the Administrator menu click Content, then +Add content.

. Click Webform.

. Add a Title.

Add Body content you wish users to see. This is optional.

. Adjust any settings, e.g., to provide a menu link or to turn off comments.
. Click Save.
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We recommend that you disable comments on the Webform content type. Go to Structure > Content types > Webform > Edit, then click on
Comment settings and change the Default comment setting for new content to Closed.



Edit Webform Test Form &

Home » Test Form

Title *
Contact Us|

Body (Edit summary)
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Please complete this form to contact us
bady p 4
Switch to plain text editor
Text format | Filtered HTML [=] More information about text formats
+ ‘Web page addresses and e-mail addresses turn into links autamatically
* Allowed HTML tags: <a> <em> <strong> <cite> <blockquote> <code> <ul> <ol> <li> <di> <dt> <dd>
+ Lines and paragraphs break automatically.
Menu settings
Not in menu © Open
Users with the "Post comments” permission can post comments.
Revision information
Na revision @ Closed
URL path settings Users cannot post comments.
Automatic alias
Comment settings
Closed
Notice the Tabs at the top right.
. View information
Edit the form ditthe f ; bmitted
; ; Edit the form rom submitte
information
fields forms
View the View
form live

activity log
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The Edit tab displays information about the Form page (node). You are taken immediately to the Edit tab when you create a new Webform.

Adding Fields to the Web Form

Once you create the page to hold the form you will need to add fields. From the Edit overlay screen, click the Webform tab.




Notice that the Webform overlay has three sub areas — Form components, E-mails, and Form settings. We'll look at each.

Test Form @

Home » Test Form
Form components E-mails Form settings

Show row weights

LABEL MANDATORY OPERATIONS

MNo Companents, add a compaonent below.

“ | New component name Textfield E

Creating the Fields or Form Components

The Form components area is where you will create the fields for your form.
To Add Fields

1. Add the field name in the New component name box.

2. Select a Type for the field display from the drop-down list.

Be sure to choose the appropriate Type. Some fields (e.g., time, number) have built in validation and some will offer the user widgets for
easy data entry (e.g., date) See explanation of types below.

Textfield

Date
E-mail
Fieldset
File
Grid
Hidden
Markup
Mumber
Fage break
select options
Textarea

Textfield displays text on single line

Textarea displays text on multiple lines

Fieldset group fields together as a unit

Hidden captures information but does not display
Markup allows you to insert html and css

Page break will force a page break within the form

Select options | lets you use radio buttons and check boxes

3. Click Add. You will see the Edit component overlay where you can adjust settings for this field.



Edit component: First name

Home » Test Form » Webform . .

Label *
First name

This is used as a descriptive label when displaying this form element.

Field Key *
first_name

Enter & machine readable key for this form element. May contain only alphanumeric characters and underscores. This key will be used as the name attribute of the form element.
This value has no effect on the way data is saved, but may be helpful if doing custom form processing

Defaulr value

I\_%prnﬂIe[pmme_ﬁrst_name] I

The default value of the field

~ TOKEN VALUES

You may use special tokens in this field that will be replaced with dynamic values.

Basic tokens

* Zusername - The name of the user if logged in. Blank for anonymous users
+ %useremail - The e-mail address of the user if logged in. Blank for anonymous users
+ Xip_address - The IP address of the user.

* site - The name of the site (i.e. Drupal journey)

* %date - The current date, formatted according to the site settings.

Node tokens

+ #nid - The node ID.
+ Ztitle - The node title

Special tokens

Zprofile[profile_fi

+ Zprofile[key] - Any user profile field or value, such as %profile[name] o
+ %get[key] - Tokens may be populated from the URL by creating URLs @
+ %post[key] - Tokens may also be populated from POST values that are submitted by forms

/my-form?foo=Dbar. Using the token %get[foo] would print “bar™.

In addition to %get and %post, the following super tokens may be used, though only with logged-in users: %server, %cookie, and ¥%request. For example
#server[HTTP_USER_AGENT] or ¥%session[id]

Description

Enter the correct first name if you are nu|%pruﬁle[pruﬂ\e_ﬂrst_name].l

A short description of the field used as help for the user when he/she uses the form.

Making Adjustments to the Field Settings

1. Edit the field Label if you desire.
2. Add a Default value (optional) which will display automatically. The user may change this.
3. Add a Description to help the user enter data in this field.

Notice the use of a token. A token is a quick way of using some information the systsem knows such as site name, user name, or date. Here the
token %profile[istdraft:profile_first_name] is used to add the person'’s first name by default to save the user time.



* VALIDATION
[C] Mandatory

Check this option if the user must enter a value.

[C] Unigue
Check that all entered values for this field are unigue. The same value is not allowed to be used twice

Maxlength

Maximum length of the textfield value.

~ DISPLAY

width

Width of the textfield. Leaving blank will use the default size
Prefix text placed to the left of the textfield
Examples: §, #, -.

Postfix text placed to the right of the textfield
Examples: |b, kg, %

Label display

Above |Z|

Determines the placement of the component’s label.

[7] Disabled

Make this field non-editable. Useful for setting an unchangeable default value.

[ Private

Private fields are shown only to users with results access I}

Save component

. Add Validation options to ensure the user enters data (Mandatory) which no one else has entered (Unique). Restrict data to a Maxlength
of characters.

. Set the maximum Width for this field (in characters).

Add a Prefix or Postfix to be added to the field data.

. Set the field Label display to appear above or below the entry box.

Check Disabled to add a unchangeable default value.

. Check Private to limit viewing of this field to those with permission.

[
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Be sure to click Save component. Repeat this process for each field you need.
To see your form click the View tab or close the overlay screen.

You can return to the Edit and Webform tabs at any point to change the web form page or edit the fields in you form.

Setting up an E-mail Alert for a Submitted Form

You can set up email alerts to be sent when a form is submitted. Click the E-mails button to set up the recipient and what will be included in the
email.

VIEW EDIT WEEBFORM RESULTS LOG

Form compaonents m Form settings

1. Click Webform, then E-mails.
2. Enter the recipient email address in the _Address_box.
3. Click Add.




H Contact Us
e bontas Form components m Form settings
E-MAIL TO SUBJECT FROM OPERATIONS

Currently not sending e-mails, add an e-mail recipient below.

@ Address: shansonf@mit.edu Add

(©) Component value:| Mo available camponents

Make Adjustments to Email Settings

1. Add additional recipients separated by commas, if necessary.
2. For the E-mail subject, E-mail from address and E-mail from name enter a value or leave the default value.
3. You can also use the value from any component of your form by choosing from the drop down list.

Edit e-mail settings @

Home

E-mail to address

@ Custom: pankin@mit_edu

@ Component: | No available components
Form submissions will be e-mailed to this address. Any email, select, or hidden form element may be selected as the recipient address. Multiple e-mail addresses may be

separated by commas

E-MAIL HEADER DETAILS

E-mail subject

@ Default: Form submission from: Comact Us
() Custom

@ Compenent: First name

Any textfield, select, or hidden form element may be selected as the subject for e-mails

E-mail from address

@ Default: pankinémit.edu
(@ Custom

© Component: | No available components

Any email, select, or hidden form element may be selected as the sender's e-mail address.

E-mail from name

@ Default: Drupal Journey
(@) Custom
@ Compoenent: First name El

Any textfield, select, or hidden form element may be selected as the sender's name for e-mails.

E-MAIL TEMPLATE
o ﬁ e ~ 5 = r SRRy

Make Edits to Email Message

1. A default email message template is provided which you can edit. Once edited, you may return to the original default by selecting Default
template from the drop down box.

2. The template uses tokens. You may add additional tokens or text.

3. The %email_values token will display any components checked in the Included Email Values area.

4. Click Save e-mail settings.



¥ E-MAIL TEMPLATE
An e-mail template can customize the display of e-mails.

Default template |z|

Submitted on %date

Submitted by user: %username
Submitted values are
Yeemail_values

The results of this submission may be viewed at
Y%submission_url

» TOKEN VALUES

T INCLUDED E-MAIL VALUES

The selected components will be included in the %email_values token. Individual values may still be printed if explicitly specified as a %temail[key] in the
template.

[T INCLUDE ALL COMPONENTS

First name
Last name
E-mail address

What's on your mind?

Save e-mail settings

Managing Form Settings

You can make several adjustments to how the form will operate from the Form settings overlay screen.

WEEBFORM

Form components m Form settings

Add a Confirmation Message

1. Click Webform, then Form settings.
2. Use the edit box to create a custom Confirmation message.
3

. Add a redirect to Confirmation page (automatically created) to have this message appear on a new page instead of a display message.
You may also create your own confirmation page and redirect to it.

4. Click Save configuration when you are finished making changes.



Fram componencs £ -maity

* SUEMISSION SETTIRGS

Canlirmation mess.age

aim tex adin

Text forman  Fitared HTML |=

B3 and g-maila

Redirection location

& Cenfirmatian page
Csstom UAL

%o rechrect {relcad currem page|

» TOEEMN WALLIES

Set Limits to Form Submission

. Click Limit to and a number to limit Total submissions. You may limit within a time range as well.

. Click Limit to and a number to limit User submissions. You may limit within a time range as well.

. You can also click Closed to stop submissions completely. You can re-open submissions at any time.

. In the Submission Access section, check the roles which you want to respond to the form, or uncheck the role(s) to prevent submission.
. Click Save configuration when you are finished making changes.
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Total submissions limit
@) Unlimited
@ Limit to total submission(s) | ever E

Limit the total number of allowed submissions.

Per user submission limit
@ Unlimited
@ Limit each user to submission(s) | ever E|

Limit the number of submissions per user. A user is identified by their user login if logged-in, or by their IP Address and Cookie if anonymous. Use of cookies may be modified
in the global Webform settings.

Status of this form
@ Open
@ Closed

Closing a form prevents any further submissions by any users

¥ SUEMISSION ACCESS

These permissions affect which roles can submit this webform. It does not prevent access to the webform page. If needing to prevent access to the webform
page entirely, use a content access module such as Taxonomy Access or Node Privacy by Role,

Roles that can submit this webform

anonymous user
authenticated user
[] content manager

[[] administrator

The authenticated wser role applies to any user signed into the site, regardless of other assigned roles.
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Set the text for submission button and other advanced settings:

1. In the Advanced Settings section, enter new text in the Submit button text box to override the default Submit text.

2. Click Available as block to make your form available to be placed on other pages as a block. You would then access the form on the
Block overlay page.

3. Click Save configuration when you are finished making changes.

* ADVANCED SETTINGS

[[] Available as block
If enabled this webform will be available as a block.
[ Show complete form in teaser
Display the entire form in the teaser display of this node.
[ Show "Save draft” button
Allow your users to save and finish the form later. This option is available only for authenticated users
[] Automatically save as draft between pages

Automatically save partial submissions when users click the "Mext™ or "Previous™ buttons in a multipage form

Show the notification about previous submissions.

Show the previous submissions notification that appears when users have previously submitted this form.

Submit button text

By default the submit button on this form will have the label Submit Enter a new title here to override the default.

Save configuration

Reviewing Submitted Data

On the overlay page for your web form, click the Results tab. This tab lets you view and download the data from your form submissions.



RESULTS

Analysis Takle Download Clear

To View a List of All Submissions

1. Onthe _Results_tab, click the Submissions button to see a list of all submission records.
2. Click a column head to sort by that column.
3. Click a name to see that person'’s profile.
4. For each record you may choose to view, edit or delete.
Contact Us ® RESULTS
Home » Contact Us Analysis Table Download Clear
Showing all results. & results total.
# - SUBMITTED USER IP ADDRESS OPERATIONS
14 2013-10-09 09:34 View Edit Delete
13 2013-10-09 09:29 View Edit Delete
12 2013-10-09 09:28 View Edit Delete
11 2013-10-09 09:28 View Edit Delete
10 2013-10-07 12:03 View Edit Delete
9 2013-10-02 13:53 View Edit Delete

When you click View in the Operations column you will see a record which looks like this. If necessary you can Edit the response or
Delete it.

Submission #14 &

Home » Contact Us » Webform results
Previous submission  Next submission
Submission information

Form: Contact Us
Submitted by
October 9, 2013

First name

Joe

Last name
Green

What's on your mind?
How do ...

Previous submission Next submission

To See a Simple Analysis of the Submissions
1. On the Results tab, click Analysis.
2. For each field you will see how many users entered information, how many left the field blank and the average length of the submissions
for that field.
To See Field Data for Each Submission in a Table Format
1. On the Results tab, click Table.
2. For each submissions the data from each field will be displayed on a row. This display becomes less useful as the number of fields in
your form grows in number.

To Download the Results from your Webform Submissions

1. On the Results tab, click Download.



Contact Us ® RESULTS

Home » Contact Us
Submissions Analysis Table Download Clear

Export format

@ Delimited text

(@ Microsoft Excel

Delimited rext format

Tab (\t) E

This is the delimiter used in the CSV/TSV file when downloading Webform resuls. Using tabs in the export is the most reliable method for preserving non-latin characters. You may
want to change this to another character depending on the program with which you anticipate importing results

» SELECT LIST OPTIONS
» INCLUDED EXPORT COMPONENTS

» DOWNLOAD RANGE OPTIONS

Download

2. Select the Export format, Delimited text or Microsoft Excel.
3. Change the Delimited text format if required. In most cases you'll want to leave this as is.

You have a number of options in the List Options, Components and Range sections.

SELECT LIST OPTIONS for choosing among download list formats; in most cases you can leave the default

INCLUDED EXPORT choose which fields to download

COMPONENTS

DOWNLOAD RANGE useful for selecting subsets of submission data to download, e.g., “Only the latest 50 submissions” or “Only new
OPTIONS submissions since your last download”.

To Clear All Submission Forms (all data)

1. Click Results, then Clear. All of your data will be deleted.
2. You will be presented with a warning message.
3. Click the Clear button.

Be sure you have downloaded and saved your data if necessary before using Clear. This cannot be undone. Also note that any new submissions
after a Clear will continue numbering from the last submission, and not begin again with the number 1.

Home » Contact Us

Are you sure you want to delete all submissions for this form? o VIEW EDIT WEBFORM RESULTS LOG

Submissions Analysis Table Download

This action cannot be undone.

Clear Cancel

See Also

® Return to Drupal Cloud Landing Page
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